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What is wrong with sending HTML or MIME messages?
There are now six main reasons for NOT doing this:

1. Many E-mail and Usenet News reader programs, usually the mail and news reader programs
that come with browser packages, allow users to include binary attachments (MIME or other
encoding) or HTML (normally found on web pages) within their E-mail messages. This
makes URLs into clickable links and it means that graphic images, formatting, and even
color coded text can also be included in E-mail messages. While this makes your E-mail
interesting and pretty to look at, it can cause problems for other people who receive your E-
mail because they may use different E-mail programs, different computer systems, and
different application programs whose files are often not fully compatible with each other.
Any of these can cause trouble with in-line HTML (or encoded attachments). Most of the
time all they see is the actual HTML code behind the message. And if someone replies to the
HTML formatted message, the quoting can render the message even more unreadable. In
some cases, the message is nothing but strange looking text. For this reason, many mailing
lists especially those that provide a digest version, explicitly forbid the use of HTML
formatted e-mail. See examples section.

When you send an attachment, like a word processor file, to have it appear on the other end
as the exact same type of file the recipient must have hardware and software that can read
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that file. For example, if you attach a Microsoft Word file, and the recipient of your message
is using a word processor that can't open MS Word files, that person isn't going to be able to
open your attachment and they are less than likely to be very happy about it.

2. HTML or MIME messages are larger and more wasteful than simple text messages. Using
HTML or MIME in E-mail messages makes the messages larger in size by a mimimum of
two thirds to more than twenty times. These will take longer to download and they take up
more storage space than standard plain text E-mail messages.

E-mail storage is important because many people retain copies of messages they receive and
in the case of mailing list digests , the individual messages are combined in one large
message and sent to the user at the end of the day. Some mailing list programs fail to format
the digest correctly if HTML messages appear. In addition, many mailing lists archive the
messages for periods of 6 months or more to enable users to search for particular past
postings.

3. HTML or MIME messages leave or include unwanted files (attachments) on the machines of
the recipients of these messages.

4. Embedded HTML or MIME attachments are the number one method of spreading virus,
worm or Trojan programs.

For instance, the Forgotten worm was written in Visual Basic Script and spread without any
attachment. Instead, the worm code was embedded into the HTML formatted message body.

The I Love You worm program exploited an ActiveX vulnerability and was executed just by
viewing or previewing the e-mail message without opening any attachment.

Likewise, embedded code could exploit some MS Office vulnerability as with Office ODBC
Vulnerabilites and Specially Formed Script in HTML Mail can Execute in Exchange 5.5

HTML messages can trigger dialups to the Internet if they contain links to specific images
called "web bugs" that are used to track message and advertiser viewing. See Web Bug FAQ

MIME encoded attachments with file extensions (BAT, COM, DOC, EML, EXE, HTA, JS,
PPT, SHS, VBE, VBS, WSH, XL#) have been the most common method of sending viruses,
worms and Trojan programs because their code will be executed by Windows and associated
viewers or other MS programs when the attachment is opened. Windows uses the extension
to determine what the default action on a file will be. For instance, a .txt file will open in
Notepad and a .html file will open in Internet Explorer.

Uncommon, but no less dangerous are file extensions (386, ACM, ACV, ADT, AX, BIN,
BTM, CLA, CPL, CSC, CSH, DEV, DLL, DOT, DRV, HLP, HTM, HTT, INF, INI, JSE,
JTD, MDB, MP#, MPP, MPT, MSO, OBD, OBT, OCX, OLE, OV#, PIF, PL, PM, POT,
PP#, PPS, PRC, RAR, RTF, SCR, SH, SHB, SMM, SYS, VSD, VSS, VST, VXD, WSF,
XL#, XLB, XTP).

5. HTML quickly fills the memory of PDAs (Personal Digital Assistants like the Palm Pilot). In
addition, many HTML messages are also completely unreadable on most PDAs.

6. Some e-mail recipients may have set their background to something other than white, may

http://www.faqs.org/rfcs/rfc1153.html
http://www.symantec.com/avcenter/venc/data/vbs.forgotten.a.html
http://www.cert.org/advisories/CA-2000-04.html
http://www.microsoft.com/technet/treeview/default.asp?url=/technet/security/bulletin/ms99-030.asp
http://www.microsoft.com/technet/treeview/default.asp?url=/technet/security/bulletin/MS01-057.asp
http://www.eff.org/Privacy/Marketing/web_bug.html
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have chosen a typeface which they find most readable and adjusted its size in accordance
with their visual acuity, normal viewing distance, monitor size and screen resolution. All this
fine tuning is completely erased by HTML e-mail.

Plain text is how your messages should be formatted when sending E-mail to mailing lists and
Usenet newsgroups or to any other recipient. Though this rule is not yet cast in "Netiquette" stone,
it is a good policy to follow if you want quick and informative responses to your questions and
wish to avoid being "flamed" as a clueless newbie.

HTML is meant for the WWW; not for mailing lists, Usenet newsgroups postings, proper business
E-mail correspondence and preferably not for personal E-mail unless the recipient is expecting it.

MIME encoded mail is generally used to send attachments that consist of pictures, sound files,
spreadsheets, word-processing documents, zip files, or other binary files to recipients that have and
use the same operating system, the same word processing program and a common E-mail program
such as Eudora, Pegasus, Netscape, or Outlook.

MIME attachments are not wanted on mailing lists, Usenet newsgroups postings, business E-mail
correspondence, and preferably not for personal E-mail unless the recipient is expecting it.

If you must send an attachment, then before you send the message with the attachment, ALWAYS
send the recipient a message telling them you are about to send them an attachment. This will, at
least, let them know to expect a message with an attachment from you.

An exception to the "no MIME attachments rule" can be made for PGP (Pretty Good Privacy),
GPG (Gnu Privacy Guard), or other "Digital ID" signed e-mail. In this case, individuals, mailing
lists, and Usenet newsgroups that use signed e-mail are probably expecting it. See MIME Security
with Pretty Good Privacy (PGP) .

For more background information see Netiquette Guidelines (RFC1855)

To see what actual HTML/MIME mail looks like in UNIX Pine, see examples section.

Turning Off HTML or MIME to use a Remailer System
There are now a variety of HTML/MIME programs, including but not limited to:

Agent/Free Agent
AOL 5.0 and earlier
AOL 6.0
AOL 7.0
AOL 8.0
AOL 9.0
AOL 6.0, 7.0, 8.0 Alternate
CompuServe 2, 3 and 4
CompuServe 2000
Earthlink 5.0

http://www.fau.edu/netiquette/netiquette.html
http://www.faqs.org/rfcs/rfc2015.html
http://www.faqs.org/rfcs/rfc1855.html
http://cypherpunks.faithweb.com/nomime.html#examples
http://cypherpunks.faithweb.com/nomime.html#agent
http://cypherpunks.faithweb.com/nomime.html#aol
http://cypherpunks.faithweb.com/nomime.html#aol6
http://cypherpunks.faithweb.com/nomime.html#aol7
http://cypherpunks.faithweb.com/nomime.html#aol8
http://cypherpunks.faithweb.com/nomime.html#aol9
http://cypherpunks.faithweb.com/nomime.html#aolcd
http://cypherpunks.faithweb.com/nomime.html#compuserve
http://cypherpunks.faithweb.com/nomime.html#compuserve2000
http://cypherpunks.faithweb.com/nomime.html#earthlink5


3/13/17 2:19 PMConfiguring Mail Clients to Send Plain ASCII Text

Page 4 of 41http://cypherpunks.faithweb.com/nomime.html

Entourage 2001 (MacIntosh)
Entourage X (MacIntosh)
Eudora Light v3.0.5 and earlier
Eudora Light v3.0.6
Eudora Pro v4.0.2 and earlier
Eudora Pro v4.2 and later
Eudora v5.0
Hotmail
IncrediMail Xe REVISED
Juno v5.0
Lotus Notes R5
Mac OS X Mail
MS Internet Explorer 4.0, 5.0, 5.50 and 6.0
MSN Explorer 6.0
MSN Explorer 7.0
MSN 8.0
MS Exchange 4.0 and other MS problems

WINMAIL.DAT (TNEF) attachments
Equal signs at end of lines
ISO 8859-1 or other character sets

MS Exchange Server 5.0
Mozilla 1.1
Mozilla Thunderbird 0.5 NEW
Netscape Communicator 3.xx
Netscape Communicator 4.0x - 4.4x
Netscape Communicator 4.5, 4.6, 4.7
Netscape Communicator 6.0 - 6.1
Netscape Communicator 6.2
Netscape Communicator 7.0 (PR1 & Final) REVISED
Netscape Communicator 7.1
Novell Groupwise
Outlook 2000
Outlook 2002
Outlook Express 4.0
Outlook Express 5.0, 5.50 and 6.00
Outlook 97 (without Service Release 1 SR1)
Outlook 97 (with Service Release 1 SR1)
Outlook 98 (Work group version)
Outlook 98 (Internet version)
Pegasus Mail 3.x
Pegasus Mail 4.x
Pine 4.x (Unix)
Pine 4.x (Windows)
Poco 2.xx
TheBat! v1.18
WebTV
Yahoo Mail

http://cypherpunks.faithweb.com/nomime.html#entourage
http://cypherpunks.faithweb.com/nomime.html#entourageX
http://cypherpunks.faithweb.com/nomime.html#eudora3
http://cypherpunks.faithweb.com/nomime.html#eudora36
http://cypherpunks.faithweb.com/nomime.html#eudora4
http://cypherpunks.faithweb.com/nomime.html#eudora42
http://cypherpunks.faithweb.com/nomime.html#eudora5
http://cypherpunks.faithweb.com/nomime.html#hotmail
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http://cypherpunks.faithweb.com/nomime.html#lotus
http://cypherpunks.faithweb.com/nomime.html#macx
http://cypherpunks.faithweb.com/nomime.html#msie
http://cypherpunks.faithweb.com/nomime.html#explorer6
http://cypherpunks.faithweb.com/nomime.html#explorer7
http://cypherpunks.faithweb.com/nomime.html#msn8
http://cypherpunks.faithweb.com/nomime.html#exchange
http://cypherpunks.faithweb.com/nomime.html#winmail
http://cypherpunks.faithweb.com/nomime.html#equalsign
http://cypherpunks.faithweb.com/nomime.html#iso8859
http://cypherpunks.faithweb.com/nomime.html#exchange5
http://cypherpunks.faithweb.com/nomime.html#mozilla11
http://cypherpunks.faithweb.com/nomime.html#mozilla05
http://cypherpunks.faithweb.com/nomime.html#comm3
http://cypherpunks.faithweb.com/nomime.html#comm4
http://cypherpunks.faithweb.com/nomime.html#comm45
http://cypherpunks.faithweb.com/nomime.html#comm6
http://cypherpunks.faithweb.com/nomime.html#comm62
http://cypherpunks.faithweb.com/nomime.html#comm7
http://cypherpunks.faithweb.com/nomime.html#comm71
http://cypherpunks.faithweb.com/nomime.html#groupwise
http://cypherpunks.faithweb.com/nomime.html#out2000
http://cypherpunks.faithweb.com/nomime.html#out2002
http://cypherpunks.faithweb.com/nomime.html#outlook4
http://cypherpunks.faithweb.com/nomime.html#outlook5
http://cypherpunks.faithweb.com/nomime.html#out97wo
http://cypherpunks.faithweb.com/nomime.html#out97w
http://cypherpunks.faithweb.com/nomime.html#out98w
http://cypherpunks.faithweb.com/nomime.html#out98i
http://cypherpunks.faithweb.com/nomime.html#peg3
http://cypherpunks.faithweb.com/nomime.html#peg4
http://cypherpunks.faithweb.com/nomime.html#pine
http://cypherpunks.faithweb.com/nomime.html#pinew
http://cypherpunks.faithweb.com/nomime.html#poco
http://cypherpunks.faithweb.com/nomime.html#thebat
http://cypherpunks.faithweb.com/nomime.html#webtv
http://cypherpunks.faithweb.com/nomime.html#yahoo
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For creators of HTML and MIME messages, here are some
suggestions

Know how your attachments are going to be sent. Bear in mind that what's reasonable for
another recipient isn't necessarily reasonable for the rest of the world. For example, sending a
Microsoft Word document as an attachment might not work out as well as you think it
should.

If options are available for turning off attachments, do so, except perhaps for specific
correspondents known to have the ability to view the attachments. This is particularly
relevant to users of mail systems in Microsoft operating environments.

Microsoft TNEF data (WINMAIL.DAT attachments), for example, which was very common
during 1996 and 1997, is not something that most Internet correspondents can presently
handle. In addition to attachments, TNEF data may include links to OLE objects, fonts,
colors, and other information that doesn't have the same form or meaning outside a Microsoft
operating environment .

Be somewhat conservative about Content-Types when sending to mailing lists or other public
forums. Watch out for multipart/alternative.
Watch character set selections and Content-Transfer encodings. For example, some
commonly used character sets in PCs use 8 bits, not the standard 7 bits.

Agent/Free Agent

Agent currently does MIME quoted printable. Free Agent does not.

The MIME quoted printable option can be configured separately for each language you have
configured in Agent.

Select Options
Select General Preferences
Select Languages
Under Usenet Text and E-mail Text, make sure MIME is off.

AOL 5.0 and earlier

AOL automatically converts all attachments to MIME when you click on the "Attach" button. So
don't use this button.

AOL 6.0

AOL now supports Multipart/Alternative formatted messages which means that a single message
sent from a user now contains a plain-text version and a formatted version. Users who use e-mail
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programs that do NOT support HTML will be able to read the plain-text version of the message
without any of the cryptic HTML codes.

Likewise, if the e-mail client supports the HTML format, then the user will read that version.

The headers will show the Content-Type line similar to:

        Mime-Version: 1.0
        Content-Type: multipart/alternative; boundary=blah...blah...
        Content-Disposition: Inline
        X-Mailer: 6.0 sub 171

AOL recommends this method to send plain text:

Make sure your font is set to Arial (which should be the default).
Type your message (in Arial) and then highlight it. Then, right mouse click, select text, then
select normal.
Send your plain text message, making sure the text is still highlighted when you send it.

The headers may show the Content-Type line similar to:

        Mime-Version: 1.0
        Content-Type: text/plain; charset="US-ASCII"
        Content-Transfer-Encoding: 7bit
        X-Mailer: 6.0 sub 336

The "Customer Care" folks at AOL also offer the following solution: Use AOL Mail on the Web to
send mail to Internet addresses that don't allow formatting - AOL Mail on the Web sends mail as
plain text only.

NOTE: To use AOL Mail on the Web you will need to signoff AOL.

The Unofficial AOL E-mail FAQ recommends that an AOL 6.0 user can turn off the HTML using
the following steps:

Change global e-mail preferences (needs to be done only once):
Go to Keyword: Preferences (or choose Preferences from the Settings menu on the
AOL 6.0 toolbar).
Click on Font, Text, & Graphics Preferences .
Click on the Reset button at the bottom of the resulting window. Do not make any
changes in the Font Preferences area of the window.
Click on the Save button.

Change a specific e-mail to plain text (must be done for every e-mail):
Compose and address the e-mail as desired.
Choose Select All from the Edit menu to highlight the entire message.
With the mouse arrow somewhere over the highlighted text, click the Right mouse
button, revealing a contextual menu.
Choose Normal from the Text menu.
Taking care not to make any further changes to the message, send it.

Note that changing the text to normal will eliminate the "blue bar" quoted text indicator, but will

http://www.aol.com/aolmail/
http://members.aol.com/adamkb/aol/mailfaq/
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not remove some HTML elements of the quoted text. The entire quoted section must be deleted
(or simply not quoted in the first place), followed by the re-entry of the text and manually quoted,
prior to changing the text to normal. Changing the text to normal will also eliminate any styled text
that would have been seen by AOL recipients of the message, which cannot be re-added. Testing
also suggests that messages with hyperlinks cannot be converted to normal text, requiring the prior
removal of the link.

AOL 7.0

If you upgrade from AOL 6.0 to AOL 7.0 and up have customized your fonts/colors, the changes
carry over during the upgrade and so you still need to go into Settings and switch back to the
defaults as described above for AOL 6.0

To turn off HTML, use the following steps:

Change global e-mail preferences (needs to be done only once):
Go to Keyword: Preferences (or choose Preferences from the Settings menu on the
AOL 7.0 toolbar).
Click on Font, Text, & Graphics Preferences .
Click on the Reset button at the bottom of the resulting window. Do not make any
changes in the Font Preferences area of the window.
Click on the Save button.

WARNING: Any attempt to change the font face, size, style, or color within the body of an e-mail
message will change the message format to HTML, as will any attempt to use a different default
font face, size, style, or color.

Lastly, you must remove your e-mail signature if it contains any styled text, as that will also change
the message format back to HTML.

Like AOL 6, AOL 7 will use HTML when quoting a message (displaying the quoted portion with a
blue line in the left margin). And like AOL 6, choosing Text - Normal will eliminate any indication
that the text was quoted. However, unlike AOL 6, the message will now be sent in plain text.
However, the quoted portion will need to be manually quoted.

AOL 8.0

This version appears to be incapable of sending plain text e-mail.

See AOL 6.0 7.0, 8.0 Alternative.

AOL 6.0, 7.0, 8.0 Alternate

Simply install the 'safe' version of AOL, version 5.0, on your computer and use it for your plain text
mailing lists. Create or use one of your 8 allowed AOL screen names to subscribe to; and to read,

http://cypherpunks.faithweb.com/nomime.html#aol6
http://cypherpunks.faithweb.com/nomime.html#aolcd
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send, and reply to the list's mail. AOL 5.0 will not send HTML or RTF encoded e-mail unless YOU
add it (stationery/background; colored, bold, or italicized text; insert an image; etc.).

Place one of the ubiquitous free AOL 6.0, 7.0, or 8.0 CDs (available everywhere!) in your CD-
ROM drive, hold down the shift key and close the tray to stop the autoplay feature. If that doesn't
work, close the install window when it comes up. Then, using "Windows Explorer" or "My
Computer", navigate to the AOL 5.0 folder (resident on all these CDs) and double-click on the
'setup' program file. Don't let the install program overwrite any other AOL version if prompted or
asked during the AOL 5.0 install.

After the install, whenever you want to send plain text e-mail to any Internet Mailing list, simply
close any later version of AOL, click on the AOL 5.0 version, sign on with your list-dedicated
screen name and send your own list e-mails without worry of offending others with HTML or RTF
encoded e-mail.

NOTE: An alternative if you are using AOL 6.0, 7.0 or 8.0 is to log on to AOL and select either
Netscape or Internet Explorer as your browser. WARNING: Do not use AOL's web browser.
Start either browser and type "www.aol.com" in the URL field. Sign on with your ScreenName and
Password. Click on "AOL Mail". You will then be able to submit messages using AOL's AOL Mail
on the Web service.

Starting with Netscape Communicator 6.2 AOL members can read and send AOL e-mail via the
browser. The browser fully supports both HTML and plain text messages and even allows you to
set specific domain names (e.g., mailing lists) to always send plain text.

AOL 9.0

Copied directly from AOL Communicator Help manual page 66

Changing Plain Text Settings

By default, AOL Communicator Mail sends messages in HTML format. Messages sent in this
format allow you to use different fonts and font sizes; underline, boldface, or italicize text; easily
create bulleted or numbered lists and links to web sites; and attach files.

Not all mail programs support HTML, and not all users prefer to receive HTML-formatted
messages. Some programs display messages in HTML format as if they were in plain text,
including HTML tags and other format coding that can make the original message difficult to read.

If you are sending a message to someone who can’t read HTML-formatted messages (also called
'rich text'), you can switch to plain text. You can also specify plain text only for messages sent to a
specific address or domain.

Messages sent in plain text lose all formatting and attachments. Replies to (and forwarded) plain
text messages are also sent in plain text.

To change the plain text setting while you are composing a message:

http://www.aol.com/aolmail/home.adp
file:///C:/Expita/Webdocs/nomime.html#comm62
http://channelevents.aol.com/flash/com_mentor/guide.pdf/
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1. Click in the message area of the Write Mail window.
2. Change the plain text setting:
3. Click the T icon just below the Subject label to toggle the message between plain text and

rich text formatting; or
4. Open the Format menu and choose Rich Text or Plain Text.

When the T icon is red, the message uses rich text. When the T icon is black, the message uses
plain text.

When you change the plain text setting from a Write Mail window, the setting 'sticks' for all
subsequent messages you write. For example, if you switch from rich text to plain text for one
message and then open a new Write Mail window, that window will also be set to use plain text. To
change the plain text setting for all messages you send to an address or domain:

1. Open the Edit menu and choose Preferences.
2. Click Advanced Options.
3. Click Add.
4. Type the email address or domain for which you want all messages to be sent in plain text. If

you specify a domain (such as example.net), you’ll have an opportunity to switch to plain
text whenever you address a message to an email address that includes that domain.

5. Click OK.

CompuServe 2, 3 and 4

NOT COMPLETE

CompuServe's main e-mail service is ASCII text based, and is not MIME compliant. However,
CompuServe provides Base-64 MIME compliant transport of attached binary files.

CompuServe versions prior to 4.02 allowed one binary attachment per e-mail message. Beginning
with version 4.02 users are allowed two binary attachments per e-mail message.

CompuServe 2000

Compuserve 2000 only supports Windows 95/98 and closely resembles AOL because it uses an
identical installation routine, the same e-mail client, and a similar interface. CompuServe 2000 also
shares the same V.90 network as AOL.

So to send plain text e-mail using CompuServe 2000, see the instructions for AOL 5.0 and earlier .

Entourage 2001 (MacIntosh)

Microsoft Entourage is a new e-mail and personal information manager that makes it easy to
communicate with others and organize your personal information.

http://cypherpunks.faithweb.com/nomime.html#aol
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Entourage comes bundled with Office:Mac 2001. It is only available for Macintosh. Since it was
built from the foundation provided by Outlook Express for Mac, the instructions are somewhat
similar to that program.

Select "Preferences" from the Edit menu then "Mail and News"
Click on "Compose" tab
Under Messages, set the pull-down menus for "Mail Format" and "News Format" to plain
text
Click the "Reply & Forward" tab, uncheck "Reply to messages using the format in which
they sent"
Click on OK

Earthlink 5.0

From the Tools menu, choose Configure
Click the Mail button
Click on the Send tab
Click the down arrow on the Send message format drop-down list and choose Plain Text
Click on OK

The text of your e-mail will now be sent as Plain Text.

Entourage X (MacIntosh)

Microsoft Entourage X complete e-mail and personal information management program designed
specifically for Mac OS X.

Entourage comes bundled with Office v.X. It is only available for Macintosh. Since it was built
from the foundation provided by Outlook Express for Mac, the instructions are somewhat similar to
that program.

Select "Mail & News Preferences" from the Entourage tab
Click on "Compose" tab
Under Messages, set the pull-down menus for "Mail Format" and "News Format" to plain
text
Click the "Reply & Forward" tab, uncheck "Reply to messages using the format in which
they sent"
Click on OK

Eudora Light v3.0.5 and earlier

You can have Eudora warn you before sending messages that contain styled text or HTML.

Click on Tools: Options
Select the Extra Warnings category
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Check the box for Warn me when I "Queue a message with Styled Text".

If you want to make sure that you never accidentally send a message with styled or HTML text,
you can have Eudora automatically discard the styles before sending any message.

Click on Tools: Options
Select the Styled Text tab
Check the box for "Discard styles before sending messages"
Click on Tools: Options
Select the Sending Mail category
Uncheck the check box for "May use quoted-printable"

This means that even if your message is filled with bold and italics, colors, and font changes, the
message will be sent out without any of this formatting; instead it will be stripped down to the basic
plain text before Eudora sends it. Also, the quoted-printable method of character encoding (used by
non-US versions for foreign character recognition) can cause some formatting problems for some
mail readers. If you do not need to type these foreign characters, you should turn off the quoted-
printable option.

Eudora Light v3.0.6

If you want to make sure that you never accidentally send a message with styled or HTML text,
you can have Eudora automatically discard the styles before sending any message.

Click on Tools: Options
Select the Sending Mail category
Uncheck the check box for "May use quoted-printable"

This means that even if your message is filled with bold and italics, colors, and font changes, the
message will be sent out without any of this formatting; instead it will be stripped down to the basic
plain text before Eudora sends it. Also, the quoted-printable method of character encoding (used by
non-US versions for foreign character recognition) can cause some formatting problems for some
mail readers. If you do not need to type these foreign characters, you should turn off the quoted-
printable option.

Eudora Pro v4.0.2 and earlier

Eudora Pro has a "Styled Text" option, which makes messages available in RTF. Currently Eudora
Pro doesn't support HTML within the body of a message. When posting a message to a mailing list,
you can click on the button on the far right of each individual message's tool bar to "Clear
Formatting." You can also set up the options to either warn you of outgoing messages that contain
styled text or to discard the styles before sending the messages:

Click on Tools: Options
Highlight (Select) Styled Text
Check either or both of these boxes:
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Warn me when I queue a message with styled text.
Discard styles before sending messages.

You can have Eudora turn off MIME encoding when sending messages that contain special
characters.

Eudora automatically uses quoted-printable (MIME) encoding if your mail contains special
characters. Eudora also uses quoted-printable encoding for attached plain text files. If your
recipients don't have MIME, then just turn off the QP button in the message icon bar when you are
sending text files to those recipients.

Eudora Pro v4.2 and later

Eudora Pro has a "Styled Text" option, which makes messages available in HTML format within
the body of a message. When posting a message to a mailing list, you can click on the button on the
far right of each individual message's tool bar to "Clear Formatting." You can also set up the
options to either send plain text or styled text or both.

Click on Tools: Options
Scroll down to and click on Styled Text Category
Check these 3 boxes:

Show formatting toolbar - If this is on, the formatting toolbar displays by default in
new message windows. If this is off, the formatting toolbar is hidden by default in new
message windows. This toolbar lets you easily format text styles in new messages.
Send plain text only
Ask me each time - If this is on, you are warned when you try to send or queue a
message with text styles. And you are given the option to send a plain text version, an
HTML version, or both in a single message.

You can have Eudora turn off MIME encoding when sending messages that contain special
characters.

Eudora automatically uses quoted-printable (MIME) encoding if your mail contains special
characters. Eudora also uses quoted-printable encoding for attached plain text files. If your
recipients don't have MIME, then just turn off the QP button in the message icon bar when you are
sending text files to those recipients.

Eudora v5.0

Eudora has a "Styled Text" option, which makes messages available in HTML format within the
body of a message. When posting a message to a mailing list, you can click on the button on the far
right of each individual message's tool bar to "Clear Formatting." You can also set up the options to
either send plain text or styled text or both.

Click on Tools: Options
Scroll down to and click on Styled Text Category
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Check these 3 boxes:
Show formatting toolbar - If this is on, the formatting toolbar displays by default in
new message windows. If this is off, the formatting toolbar is hidden by default in new
message windows. This toolbar lets you easily format text styles in new messages.
Send plain text only
Ask me each time - If this is on, you are warned when you try to send or queue a
message with text styles. And you are given the option to send a plain text version, an
HTML version, or both in a single message.

You can have Eudora turn off MIME encoding when sending messages that contain special
characters.

Eudora automatically uses quoted-printable (MIME) encoding if your mail contains special
characters. Eudora also uses quoted-printable encoding for attached plain text files. If your
recipients don't have MIME, then just turn off the QP button in the message icon bar when you are
sending text files to those recipients.

Hotmail

Click on "Compose tab", address the message and fill in the "Subject" line
Before composing the message, click on "Tools" (next to "Copy message to sent folder")
Click on "Rich-text editor OFF" to set off
NOTE: The toggle is actually counter-intuitive. That is, if the drop menu choice says "Rich -
Text Editor OFF" RTF formatting is on. When the toggle shows "Rich -Text Editor ON"
RTF formatting is off.
If you receive a pop up message "Are you sure you want to do this?" Click "OK" and wait for
text formatting tools to disappear
NOTE: If you are using Netscape, then you will NOT be given the the choice to turn
ON/OFF RTF formatting. Messages will be sent in plain text format.
Compose your plain text message
Send your plain text message

IncrediMail Xe

IncrediMail is an advanced e-mail client that offers interactive features. You can choose from an
assortment of e-mail backgrounds, animations, sounds, 3D effects, e-cards, emoticons, dancing
letters, and random notifier selections. Also has support for MSN e-mail and Windows XP.

To change a single e-mail message to plain text:

From within the "New Mail" window, open the "Message" menu and select "Plain Text".
At this point, a dialog window will appear. Click "Yes" to confirm changing your e-mail to
plain text format.

To change the default e-mail message format to plain text:



3/13/17 2:19 PMConfiguring Mail Clients to Send Plain ASCII Text

Page 14 of 41http://cypherpunks.faithweb.com/nomime.html

From the IncrediMail main window, open the "Tools" menu and select "Options".
From the Options window, select the "Advanced" tab.
In the Message section, check the "Enable 'Plain Text' in Style Box" checkbox.
Click OK.

When sending mail, always select "Plain Text".

Create a new message by selecting the "New Mail" button from the Toolbar.
Select the "Letters" category in the "Style Box".
Make sure "Plain Text" is selected.

NOTE: The first item in any collection is "Plain Text".

If using a Signature, make sure you only use the text section titled "Add signature text below:"
NOTE: Do Not create a handwritten signature.

If you have a customized handwritten signature, then make sure you don't include it.

On the Main menu, select Tools then Options, and click on the Compose tab.
Uncheck the "Automatically insert signature to outgoing messages" box.

Juno v5.0

With Juno you can now send HTML e-mail as well as plain text messages. The default format for
new messages you compose in the Write screen is plain text. As you write your message and add
any kind of formatting (color, images, font), the format automatically changes to HTML. If you
know that the person you are sending the message to uses an e-mail program that is not HTML
compatible, make sure to change the message format to plain text (otherwise, the person might not
be able to read your message).

To change the e-mail message format to plain text:

On the Edit menu, point to E-mail Message Format, point to View as and click Plain Text.
In the Remove Formatting dialog box, click Yes to change the format.

Outlook 2000

Select "Tools" then click on "Options..."
Click on "Mail Format" tab
In the "Message Format" section, the pull-down menu in "Send in this message format" list
offers three choices: Plain Text, Microsoft Rich Text, and HTML. Select Plain Text. 
NOTE: there is a "Send e-mail using plain text only" checkbox on the properties sheet of an
address book entry, but it doesn't do anything if you have the HTML mail format selected
here.
Make sure the check box is unchecked (empty) in front of "Use Microsoft Word to edit e-
mail messages". 
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NOTE: Outlook Help states that you can switch message formats after starting an e-mail
message, but this doesn't work if you use Word as your e-mail editor, only if you use the
internal Outlook mail editor (and then only switch between plain text and HTML formats).
Click OK

WARNING: Outlook 2000 uses what Microsoft calls Auto Format Reply. Due to the variety of
message formats supported by different e-mail clients, Outlook 2000 ensures that e-mail recipients
receive replies they can read easily. When users reply to a message, Outlook automatically uses the
format of the original message. This is especially frustrating if you receive HTML e-mail and wish
to send Plain Text e-mail.

To override the default for any individual message, click on the "Format" menu within the message
and choose the desired format. Outlook 2000 lets you select the e-mail format for a mail message in
what they call one-off editor switching. You can start a new message in a different format than the
standard one by selecting New Mail Message Using from the Actions menu.

Outlook doesn't have any way to select the mail format to use when sending mail to a particular
recipient when you use the drop-down list on a Contact item or an Address list entry.

NOTE: A problem you may encounter when you open an incoming e-mail message, you may see a
blank message or three less than symbols (<<<) displayed instead of the message text.

In some cases, depending on the Internet e-mail software used, the message may contain other
random, unrelated characters or the message body may be blank.

Microsoft describes this behavior in the Knowledge Base article (OL2000: Message Received from
Outlook Express 5 May Contain Unrelated Characters)

NOTE: You may notice that plain text messages do not word wrap properly when you print the
message, or view it in print preview. To resolve this problem you may need to obtain Microsoft
Office 2000 Service Release 1/1a (SR-1/SR-1a) .

Microsoft describes this behavior in the Knowledge Base article (OL2000: Plain Text Messages
Word Wrap Incorrectly When Printed)

WARNING: If you are using a version of Outlook 2000 that has been installed with the corporate
workgroup installation you may discover that when you set e-mail to send "Plain Text" that it has
been changed to "Quoted-Printable" instead of 7-bit or ASCII.

Microsoft describes this behavior in the Knowledge Base article (Q269186 The Message Received
by the Recipient Is Different)

WARNING: If you send messages with multiple file attachments to America Online (AOL) users,
they do not receive the messages in a readable format. AOL combines the text of the message and
the attachments into a single MIME (.mim) file.

AOL users who receive messages as MIME files can open them using WinZip in Classic mode.
The message text and all of the attachments are displayed intact.

Microsoft describes this behavior in the Knowledge Base article (OL2000: Messages with Multiple

http://support.microsoft.com/support/kb/articles/Q240/3/33.ASP
http://support.microsoft.com/support/kb/articles/Q245/0/25.ASP
http://support.microsoft.com/support/kb/articles/Q242/3/88.ASP
http://support.microsoft.com/default.aspx?scid=KB;en-us;q269186
http://www.winzip.com/
http://support.microsoft.com/support/kb/articles/Q223/9/11.ASP
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Attachments Sent to AOL Users Do Not Display Correctly)

Outlook 2002

Outlook 2002 eliminates the distinction between Corporate/Workgroup and Internet Mail Only
modes that made supporting Outlook 98 and Outlook 2000 so difficult. You can now change the
format of a message you already received or created to make the message either easier for you to
view or to send to someone else.

With the message open, on the menu bar: select "Format"
On the "Format" menu Select the format you want to change the message to: The menu list
offers three choices: Plain Text, Microsoft Rich Text, and HTML. Select Plain Text.
If Microsoft Word is your e-mail editor, these options may not be available. 
NOTE: Outlook Help states that you can switch message formats after starting an e-mail
message, but this doesn't work if you use Word as your e-mail editor, only if you use the
internal Outlook mail editor (and then only switch between plain text and HTML formats).

Outlook 2002 supports better reading and printing of plain text mail messages by allowing the user
to remove extra paragraph marks. They are easily restored if you need them, for example to format
tabular data. To turn this feature on or off,

Choose "Tools"
Select "Options"
Select "Email Options"
Select "Remove extra line breaks in plain text messages."

WARNING: There are known problem with this feature. See:

OL2002 AutoClean Feature Removes Unwanted Line Breaks
OL2002 Posts Do Not Honor Line Breaks in Plain Text Format

NOTE: If your POP/SMTP account requires you to authenticate via the POP account before
sending via the SMTP address (like Yahoo mail), Outlook 2002 can handle this: OL2002: Unable
to Send Mail By Using Yahoo After Upgrading to Outlook 2002 (Q289945)

WARNING: In earlier versions of Microsoft Outlook, you had the ability to break apart messages
that were larger than a specified size ranging from a value between 16 KB (kilobytes) and 8000
KB. This capability has been removed from the product in Outlook 2002. See this Knowledge Base
article: OL2002: The Option to Break Apart Large Messages Is Missing (Q287766)

NOTE: The setting to adjust the line length of plain text messages no longer works. Even if you
change it from the default of 76 characters, Outlook 2002 appears to always use 72 characters as
the line length.

WARNING: You cannot set the default format for Internet plain text messages to quoted-printable
(which puts in soft returns, not hard returns at the end of each line). This makes long URLs in plain
text messages unusable. A Microsoft Knowledgebase article describes how to modify the registry
to set the default encoding format for plain text messages to quoted-printable. See OL2002: How

http://support.microsoft.com/support/kb/articles/Q223/9/11.ASP
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q295014
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q287816
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q289945
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q287766
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q278134
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Outlook Applies Encoding to Plain Text Messages (Q278134).

However, this setting may not work. As stated in the article, "Whether or not Outlook honors this
registry setting depends on what software creates MIME on the user's behalf; when Outlook uses
Exchange to send the message, Outlook does not honor this registry setting." While it does set the
Content-Transfer-Encoding to quoted-printable, Outlook performs only partial Base64 or MIME
encoding -- handling 8-bit characters, but not soft line feeds.

NEW FEATURE: Outlook 2002 SR-1 ( OL2002: Overview of the Outlook 2002 Public Update:
October 4, 2001 (Q300551) (also part of MS Office XP Service Pack 1 (SP-1) OFFXP: How to
Obtain the Latest Office XP Service Pack (Q307841) ) has a feature that converts all incoming
HTML mail to plain text. See OL2002: Users Can Read Nonsecure E-mail As Plain Text
(Q307594) for details and possible side affects.

MS Internet Explorer 4.0, 5.0, 5.50 and 6.0

Unfortunately Microsoft Internet Explorer versions 4, 5, 5.50, and 6 come packaged with the
program Outlook Express as its mail client whose default configuration is to send HTML formatted
mail.

To configure Outlook Express to send text only messages see appropriate Outlook Express sections
below:

Outlook Express 4.0

Select "Tools" then click on "Options..."
Click on "Send" tab
In the "Mail Sending Format" and "News Sending Format" sections, click on "Plain Text"
bullet in both places
In the "Mail Sending Format" section, click on "Plain Text Settings..." button.
In the "Plain Text Settings" window and the Message format section

Click MIME bullet
Set "Encode text using:" to None.
Uncheck the "Allow 8-bit characters in headers"
Set Automatically wrap text at 72
Check the box in front of "Indent original text with > when replying or forwarding"
Click OK

In the "News Sending Format" section, click on "Plain Text Settings..." button.
In the "Plain Text Settings" window and the Message format section

Click MIME bullet
Set "Encode text using:" to None.
Uncheck the "Allow 8-bit characters in headers"
Set Automatically wrap text at 72
Check the box in front of "Indent original text with > when replying or forwarding"
Click OK

While still in the "Send" tab, Uncheck "Reply to messages using the format in which they

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q278134
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q300551
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q307841
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q307594
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were sent"
Click on "OK" and on "OK" again.

All of your messages will now be sent as plain text. Outlook Express 4.x can also be configured to
send Business Cards (also referred to as vCards) with your e-mail. These are attachments, which
show up as strings of unreadable code on most mailing lists. To turn these off:

Select "Tools" then click on "Stationery..."
In the "Signature" area, click on the "Signature" button.
In the "Personal Business Card" area, uncheck the check box in front of "Attach card to all
outgoing messages"
Click on "OK" and on "OK" again.

Outlook Express 5.0, 5.50, and 6.00

Select "Tools" then click on "Options..."
Click on "Send" tab
In the "Mail Sending Format" and "News Sending Format" sections, click on "Plain Text"
bullet in both places
In the "Mail Sending Format" section, click on "Plain Text Settings..." button.
In the "Plain Text Settings" window and the Message format section

Click MIME bullet
Set "Encode text using:" to None.
Uncheck the "Allow 8-bit characters in headers"
Set Automatically wrap text at 72
Check the box in front of "Indent the original text with > when replying or forwarding"
Click OK

In the "News Sending Format" section, click on "Plain Text Settings..." button.
In the "Plain Text Settings" window and the Message format section

Click MIME bullet
Set "Encode text using:" to None.
Uncheck the "Allow 8-bit characters in headers"
Set Automatically wrap text at 72
Check the box in front of "Indent the original text with > when replying or forwarding"
Click OK

While still in the "Send" tab, Uncheck "Reply to messages using the format in which they
were sent"
Click on "Apply" and then on "OK".

NOTE: It has been brought to my attention that Outlook Express occasionally breaks all lines at
the set margin after you send an e-mail message on a reply or forward. So the lines Outlook
Express marks with "> " get wrapped after the "> " mark and the recipeient gets something awful to
look at and entirely different than what it looked like before you sent it.

To prevent this from happening, you may want to set the margin at 132 (maximum possible value)
and break the lines at 72 to 75 characters manually.
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All of your messages will now be sent as plain text. Outlook Express can also be configured to send
Business Cards (also referred to as vCards) with your e-mail. These are attachments, which show
up as strings of unreadable code on most mailing lists. To turn these off:

Select "Tools" then click on "Options..."
Click on "Compose" tab
In the "Business Cards" area, uncheck the check boxes in front of Mail and News for
"Include my business card when creating new messages."
Click on "Apply" and then on "OK".

Mozilla 1.1

Select "Edit" then click on "Preferences..."
Click on the plus sign before "Mail & Newsgroups"
Click on "Message Composition" in left pane
In the "Forwarding and Replying to Messages" section, change the "Forward messages:" to
Inline.
In the "Composing Messages" section, unckeck the box in front of "For messages that
contain 8-bit characters..."
Click on "Send Format" in left pane
In the section "When sending message in HTML format...", click on the bullet in front of
"Ask me what to do..."
Click on "OK".

Note the section titled "Plain Text and HTML Domains". You should add your mailing list domains
under the "Plain Text Domains" to ensure that all e-mail sent to a mailing list is always in plain
text.

When in a new message screen (Compose)

Select "Options" in the taskbar
Select "Format"
Click on "Plain text only". The default is probably shown as "Auto-Detect"
Send the message

Mozilla Thunderbird 0.5

Select "Tools" then click on "Account Settings..."
Under an account, select "Addressing & Composition" in the left pane
In the "Composition" section, uncheck "Compose messages in HTML format"
Repeat the above 2 steps for each account you have set up in Thunderbird
Click on "OK"
Select "Tools" then click on "Options"
Click on "Composition" in left pane
In the "Forwarding Messages" section, change the "Forward messages:" to Inline
In the "Composing Messages" section, uncheck the box in front of "For messages that
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contain 8-bit characters..."
In the "Send Options" section, click "Send Options"
In the "Text Options" section, select "Ask me what to do..." from the dropdown
Click on "OK"

If you have followed the instruction above, your e-mail should now always be sent as "Plain Text".
If you would like to send a message in HTML format, then hold down the Shift key while clicking
on the Compose or Reply button and the current e-mail message will be in HTML edit format.

Netscape Communicator 7.1

Start Mail & Newsgroups
Click "Edit"
Select "Mail & Newsgroups Account Settings"
Uncheck the box in front of "Compose Messages in HTML Format"

As an alternative, you can select "View Settings for this Account" under "Accounts" after
starting "Mail & Newsgroups".

Click OK

Netscape Communicator 7.0 (PR1 & Final)

Select "Edit" while in "Mail"
Click on the arrow symbol before "Mail & Newsgroups"
Uncheck the box in front of "Compose Messages in HTML Format"
Click OK

Netscape Communicator 6.2

Select "Edit" then click on "Preferences..."
Click on the arrow symbol before "Mail & Newsgroups"
Click on "Message Composition" in left pane
In the "Forwarding and Replying to Messages" section, change the "Forward messages:" to
Inline.
In the "Composing Messages" section, unckeck the box in front of "For messages that
contain 8-bit characters..."
Click on "Send Format" in left pane
In the section "When sending message in HTML format...", click on the bullet in front of
"Ask me what to do..."
Click on "OK".

Note the section titled "Plain Text and HTML Domains". You should add your mailing list domains
under the "Plain Text Domains" to ensure that all e-mail sent to a mailing list is always in plain
text.
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When in a new message screen (Compose)

Select "Options" in the taskbar
Select "Format"
Click on "Plain text only". The default is probably shown as "Auto-Detect"
Send the message

Netscape Communicator 6.0 - 6.1

Select "Edit" then click on "Preferences..."
Click on the arrow symbol before "Mail & Newsgroups"
Click on "Message Composition" in left pane
In the "Forwarding and Replying to Messages" section, change the "Forward messages:" to
Inline.
In the "Composing Messages" section, unckeck the box in front of "For messages that
contain 8-bit characters..."
Click on "Send Formatting" in left pane
In the section "When sending message in HTML format...", click on "Ask me what to do..."
Click on "OK".

When in a new message screen (Compose)

Select "Options" in the taskbar
Select "Format"
Click on "Plain text only". The default is probably shown as "auto detect"
Send the message

Netscape Communicator 4.5, 4.6, 4.7

Unfortunately, Netscape Communicator 4.5, 4.6, 4.7 also come packaged with mail programs
whose default configuration is to send HTML formatted mail.

Select "Edit" then click on "Preferences..."
Click on the plus sign "+" before "Mail & Newsgroups"
Click on "Messages" in left pane
In the "Forward and Replying to Messages", change the "By default, forward messages:" to
Inline.
In the "Send messages that use 8-bit characters", click on "As is".
Click on "Formatting" in left pane
In the section "Message formatting", click on "Use the plain text editor to compose
messages"
In the section "When sending HTML mail messages...", click on "Ask me what to do..."
Click on "OK".

Netscape Messenger can also be configured to send Address Book Cards (also referred to as
vCards) with your e-mail. These are attachments, which show up as strings of unreadable code on
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most mailing lists. To turn these off:

Select "Edit" then click on "Preferences..."
Click on the plus sign "+" before "Mail & Newsgroups"
Click on "Identity" in the left pane
Uncheck the check box that says "Attach my personal card..."
Click on "OK"

Netscape Communicator 4.0x - 4.4x

Unfortunately, Netscape Communicator 4 also comes packaged with mail programs whose default
configuration is to send HTML formatted mail.

Select "Edit" then click on "Preferences..."
Click on the plus sign "+" before "Mail and Groups & Messages"
Click on "Messages"
Uncheck the check box that says "By default, send HTML messages".
Click on "More Options..."
In the section "When sending HTML messages to recipients who are not listed as being able
to receive HTML", click "Always convert the message into plain text (may lose some
formatting)"
Click on "OK" and on "OK" again.

Netscape Messenger can also be configured to send Address Book Cards (also referred to as
vCards) with your e-mail. These are attachments, which show up as strings of unreadable code on
most mailing lists. To turn these off:

Select "Edit" then click on "Preferences..."
Click on the plus sign "+" before "Mail and Groups & Messages"
Click on "Identity"
Uncheck the check box that says "Always send Address Book Cards"
Click on "OK"

Netscape Communicator 3.xx

Unfortunately, Netscape Communicator 3 also comes packaged with mail programs whose default
configuration is to send HTML formatted mail.

Click "Tools" then click on "Mail Options"
Click on the "Send" tab.
In the "Mail Sending Format" area, click the check box next to "Plain Text"
Click on "Settings..."
In the section "Message Format", click "MIME". In the check box next to "Encode text
using", select "None".
Uncheck the check box next to "Allow 8-bit characters in headers"
Click on "OK"
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Outlook 97 (without Service Release 1 SR1)

The original version of Outlook 97 (the one without the Office 97 Service Release 1 (SR1)
installed) automatically formats all messages you send when you hit the "Reply" button in Rich
Text Format, which then shows as an attachment on a mailing list (or in any e-mail program other
than Microsoft Exchange or Outlook). This "Reply bug" can be fixed in any of the following four
ways:

1. Download and install the Office 97 Service Release 1 (SR1)
2. Download and install inetmail.exe which updates Outlook 97.
3. In the E-mail box, double-click the e-mail address. Clear the "Always send to this recipient in

Windows Messaging Rich Text Format" check box. (Note: This must be done *each* time a
message is sent via the Reply button.)

4. Download and install "RTFGuard" written by Ben Goetter This will alert you when a
message is about to be sent with RTF formatting, giving you the option to discard the
formatting before sending.

If you are using your Outlook 97 address book to send messages to the mail list, make certain you
do not have Rich Text Format selected for that address book entry:

Open the "Personal Address Book"
Double Click on the recipients name
Uncheck the check box " Always send to this recipient in Windows Messaging Rich Text
Format"
Close Options window

Outlook 97 (with Service Release 1 SR1)

Select "Tools" then click on "Options..."
Click on "Internet E-mail" tab
Click the circle next to "MIME" and not "UUENCODE"
Uncheck the check box "Allow 8-bit characters in headers"
Check the "Line wrap" box and set to 80 or less. Preferably 72
Make sure to use "US ASCII" character set
Click "OK"

If you are using your Outlook 97 address book to send messages to the mail list, make certain you
do not have Rich Text Format selected for that address book entry:

Open the "Personal Address Book"
Double Click on the recipients name
Uncheck the check box " Always send to this recipient in Windows Messaging Rich Text
Format"
Close Options window

http://officeupdate.microsoft.com/downloadDetails/sr1off97detail.htm
ftp://ftp.win.net/pub/usa/inetmail.exe
http://www.darkweb.com/%7Ebeng/exchange/rtfguard.htm
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Outlook 98 (Work group version)

Select "Tools" then click on "Options..."
Click on "Mail Format" tab
In "Send in this message format" area, select "Plain Text" from the drop- down box.
Click on "Internet E-mail" tab
In "Internet E-mail Sending Format" area, click the circle next to "MIME".
Uncheck the check box "Allow 8-bit characters in headers"
In the drop down box "Encode text using:", select "none"
Click "OK"

Outlook 98 (Internet version)

Select "Tools" then click on "Options..."
Click on "Mail Format" tab
In "Mail Formatting" area, select "Plain Text" from the drop- down box.
Click on "Settings..." button
Select "MIME"
In the drop down box "Encode text using:", select "none"
Click "OK"

MSN Explorer 6.0

MSN Explorer Tech support states "that MSN Explorer and MSN.com send web-based HTML e-
mail ONLY and cannot be configured to send plain text."

However, if you use MSN as your mail service (i.e., username@msn.com) you can simply go to
Hotmail.com and send e-mail from there in plain text (via their so-called PASSPORT system).
Same inbox, address book, etc.

You just have to remember to send or reply to POP3 and plain text e-mail from Hotmail and not
from MSN. A real nuisance but at least an option.

Unfortunately the transfer to Hotmail from MSN e-mail takes you through 3 screens and requires
you to reenter your password even if you checked the "remember my password" box.

See Hotmail above for details on how to send plain text e-mail.

MSN Explorer 7.0

MSN Explorer Tech support states "that MSN Explorer and MSN.com send web-based HTML e-
mail ONLY and cannot be configured to send plain text."

With version 7.0 of MSN you are now automatically connected to MSN Hotmail.com, MSN
Messenger Service and MSN calendar so that you no longer have to retype passwords.

http://cypherpunks.faithweb.com/nomime.html#hotmail
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If you use your MSN Hotmail sign-in name as your MSN Messenger sign-in, you can simply click
on the Hotmail.com link to logon directly to send plain text e-mail from Hotmail.

You just have to remember to send or reply to POP3 and plain text e-mail from Hotmail and not
from MSN.

MSN 8.0

Go to your MSN mail Inbox
Click on "E-mail settings" which is on the left side of the screen
Click on "Writing E-mail Settings" second on the list
Click on 4th item down, "Test Formatting"
At the "How Do You Want To Format Your Messages" box, click on second button down
"Use Plain Text for Compatibility..." In addition, choose the default encoding "Western
European ISO" when sending e-mails
Save changes at the bottom of the screen
Click on "Mail and more" on the top toolbar to return you to your MSN Inbox

MS Exchange v4.0 (Win 3.x, 95/98, and NT)

From the Microsoft Exchange toolbar select "Tools"
Select the "Services" tab.
Highlight "Internet Mail"
Click on "Properties..." An "Internet Mail, General" window will appear.
Select "Message Format..." then make sure "Use MIME when sending messages" is
unchecked. If you turn off MIME here, it will send attachments UUEncoded.
Next, select "Character Set..." in the "Message Format" window

In the "UUENCODE Character Set" window
Click the down arrow that shows next to the rectangular "window" below where it says
"specify a character set for message" text. A set of options will appear, including both
"ISO 8859-1" and "US ASCII".
Check "US ASCII", then click "OK". This will remove equal signs and "=3D" codes in
messages.
Then click "OK" on the "Options" menu.

NOTE: As you close the various windows on the way back a message will appear, advising that
"configuration changes will not take effect until the next time you log onto Internet Mail".

MS Exchange Server 5.0

It is possible to set up "Internet Mail service" to not send HTML. This is really more server related
but some people have found the information useful.

Microsoft Exchange Server 5.5 Documentation

http://www.microsoft.com/exchange/en/55/help/documents/server/xog05005.htm?id=415
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NOTE: If using these instruction to set up your server to send plain text e-mail, then you should set
all options for HTML/MIME to "never" or "disable".

WINMAIL.DAT

When I send mail to an Internet mailing list, its members complain that my messages contain big
binary attachments called WINMAIL.DAT. What's happening? How can I get rid of these?

Either intentionally or accidentally, you have been sending messages in Microsoft rich text format
to recipients using mail programs that cannot decipher this format.

When Exchange thinks that it is sending mail to another Exchange user on the Internet, Exchange
(more properly, the Internet Mail message service provider) encodes the message, along with
attached files, embedded OLE objects, and their associated icons, into a special data block called
the TNEF (pronounced tee-neff) block. This block can be seen in the mail header and looks similar
to:

        ------ =_NextPart_000_01BB9403.FCDBDA20
        Content-Type: application/ms-tnef
        Content-Transfer-Encoding: base64

This block encapsulates the complete original content of the Exchange message, so that the
message arrives at its destination with all proper formatting intact, including boldface, underlining,
fonts, and colors. Otherwise, Exchange formats the message in an Internet standard fashion,
discarding all rich text attributes and ensuring that all attached files appear as standard attachments.

The problem arises when people not using Exchange or Outlook receive a message in the TNEF
format instead of seeing a formatted message, they see a big chunk of UUENCODEd data if the
sender used UUENCODE format, or a MIME body part application/ms-tnef if the sender used
MIME. Depending upon which mail program they use, they may either see a long sequence of
hexadecimal digits, or they may see an attached binary file named WINMAIL.DAT.

Exchange specifies whether it emits TNEF or not as a property of the recipient, appearing as a field
on the property page of the underlined recipient object within an Exchange To or Cc field. (The
underline in the To field means that Exchange has recognized the name, and associated an address
and other information with it.) To see this recipient property page, double click the underlined
recipient: when using either the Internet Mail provider or Microsoft Exchange Server, the popup
that appears should include a check box labeled Send to this recipient in Microsoft rich text format.
If this check box is set, Exchange/Internet Mail will use a TNEF block when sending messages to
that user; otherwise, it will strip the rich information and send plain text. The sender can also set
and clear this flag on entries in the Personal Address Book. Should the sender address a message
using an entry from the Address Book, Exchange will use the setting of this flag from that entry.

Never set this check box if you suspect that your recipient isn't using Exchange or Outlook, or if
you are sending mail to an Internet mailing list. Otherwise, your mail will include binary garbage.

Here's how to turn it off:
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Step #1:

Double click on the Mail and Fax icon in Control Panel.
Click on the Services tab, and select Internet Mail from the list. If Internet Mail is not listed,
click Add - add this service.
Click Properties, and then Message Format.
Turn off the option that reads Use MIME when sending messages.
Click OK and then OK again.

Step #2:

Double click on the name of each recipient in your Address Book.
Turn off the option that reads Always send to this recipient in Microsoft rich text format.
This option needs to be set for each recipient of a message - if even one has this turned on, all
recipients will still get the attachment.

NOTE: Either of these methods should work for most users, but sometimes nothing seems to work
- yet another brilliant design strategy by Microsoft. If you plan to be sending lots of internet e-mail,
you should seriously consider using a mail program more suited to the task, such as Pegasus or
Eudora.

NOTE: A bug ("feature"?) in Exchange may cause line feeds to be replaced with equal signs when
rich text mail is disabled.

Unfortunately, there are several ways to send Internet mail messages in TNEF format by accident.

If you address the message by typing a literal name@domain.xxx SMTP address, or by
entering the address in Exchange's explicit one off format - i.e., by typing
[SMTP:name@domain.xxx] - and you use the version of Microsoft Exchange released with
retail Windows 95 (as opposed to Windows Messaging, or the version released as the client
of Microsoft Exchange Server), the entry will have its Send to this recipient in Microsoft rich
text format check box set by default.
If you address the message by typing a name and letting the system pick an entry from your
Personal Address Book, and that address book entry specifies Send to this recipient in
Microsoft rich text format, then the recipient in the message will, too.
If you address the message by giving the reply command in Exchange, and the message to
which you were replying had an explicit RFC822 Reply-To header (such as is the case on
many messages arriving via Internet mailing lists), and you use a version of the Internet Mail
provider prior to the Internet Mail Enhancement Patch (IMEP), the resulting entry in the To
field will have its Send to this recipient in Microsoft rich text format check box set by
default. Note that a reply will never reference an entry in your Personal Address Book unless
you replace the contents of the reply note's To field yourself.

Some workarounds:

If you are using the original version of retail Windows 95 Microsoft Exchange, update to a
more recent version, such as the Windows Messaging update.
Know the contents of your Personal Address Book, and ensure that you have not erroneously
set the rich text flag on any entries therein.
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Use the most recent version of the Internet Mail message service provider. (Note: Microsoft
Exchange Server users do not use this component, since they send mail to the Internet
through a component of Exchange Server.)
On replies to Internet mailing lists, manually clear the rich text flag, or else replace the reply
address with a known entry from your Personal Address Book.
Use "RTFGuard" or Rich Text Sentry widget, which watches for outgoing Internet messages
in rich text format, or install a recent version of Internet Idioms and configure it to do
likewise.

Microsoft has their own explanation of this phenomenon in the Knowledge Base article Q136204
(XCLN: Sending Messages In Rich-Text Format)

Microsoft also has an article on how to prevent WINMAIL.DAT from being sent in the Knowledge
Base article Q138053 (XFOR: How to Prevent the Winmail.dat File from Being Sent to Internet
Users)

Two other Knowledge Base articles also provide futher information Q280332 (OL2000 Outlook
Sends HTML Messages to the Internet When You Use an Exchange 2000 Mailbox) and Q241538
(OL2000: How Message Formats Affect Internet Mail).

The entire preceding discussion assumes that you are using either the Internet Mail (SMTP/POP3)
or Microsoft Exchange Server messaging service. If instead you are using the Microsoft Mail
messaging service, and depending on a Microsoft Mail gateway to carry your message onto the
Internet, you are out of luck, unless you have a gateway clever enough to strip WINMAIL.DAT.

Equal signs at end of lines

When I send mail to Internet users, they complain that my text has equals signs at the end of each
line. What is this? How can I make it stop?

You are sending your messages in the MIME message format. The Microsoft Internet Mail
program sends plain text messages in a MIME format called Content-Transfer-Encoding: Quoted-
Printable. The mail header usually shows something similar to:

        Mime-Version: 1.0
        Content-Type: text/plain; charset=iso-8859-1
        Content-Transfer-Encoding: quoted-printable

If you find this bothersome, you have several options. You can keep all of your lines less than 76
characters long, in which case the Internet Mail service provider will not have to insert these soft
line break sequences. You can send your mail in a format other than MIME, via the Message
Format setting. If your correspondent is using Exchange, you can specify that Exchange send rich
text along with the message. Or your correspondent can use a MIME mail reader, which
presumably will know how to handle this encoding correctly.

Some e-mail programs, most notably those from Microsoft that use quoted-printable encoding can
encode high order ASCII characters using a scheme where the equal sign ("=") indicates a character
to be decoded followed by the hexadecimal string value of the character to be encoded. This system

http://www.darkweb.com/%7Ebeng/exchange/rtfguard.htm
http://support.microsoft.com/support/kb/articles/q136/2/04.asp
http://support.microsoft.com/support/kb/articles/Q138/0/53.ASP
http://support.microsoft.com/default.aspx?scid=KB;en-us;q280332
http://support.microsoft.com/default.aspx?scid=KB;en-us;q241538
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of course assumes that the client e-mail program can decode these characters (which most can).
Things that trigger automatic quoted-printable encoding:

1. High order characters - characters with the following ordinal values 0..31,61,128..255
2. Long lines in a message body (you can turn wordwrap on to fix this)

If your message contains extended characters coded in quoted-printable format your e-mail client
may append the following preamble to your message:

Sender composed mail containing characters not in the US-ASCII set
These characters have been transformed into a printable form.

This is identified in the mail header under the Content-Type line similar to:

        Mime-Version: 1.0
        Content-Type: text/plain; charset=iso-8859-1
        Content-Transfer-Encoding: quoted-printable

To correct this, change your default character set from ISO 8859-1 to US ASCII, or else take any of
the precautions listed above. For more information, see the Knowledge Base articles Q146629
(Microsoft Exchange Internet Mail Lines End with a "=") and Q168779 OLEXP: No Quote
Characters When Using Quoted Printable Format . The mail headers should then show:

        Content-Type: text/plain; charset=us-ascii

Note that the Exchange Server Internet Mail Connector (IMC) only encodes content this way on
multipart MIME messages. When the IMC processes a message lacking extended characters or
attachments, it instead hard wraps the plain text.

ISO 8859-1 or other character set

This is identified in the mail header under the Content-Type line similar to:

        Content-Type: text/plain; charset=iso-8859-1

To correct this, change your default character set from ISO 8859-1 to US ASCII.

For Windows 95 do the following:

In Control Panel, double-click Mail And Fax.
Click Internet Mail, and then click Properties
On the General tab, click Message Format, and then click Character Set.
Change the option from ISO 8859-1 to US ASCII, or click the "Use MIME when sending
messages" check box to clear it.

For Windows 98 this is controlled in Outlook and Outlook Express.

Lotus Notes R5

http://support.microsoft.com/support/kb/articles/q146/6/29.asp
http://support.microsoft.com/support/kb/articles/q168/7/79.asp
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By default all mail in Lotus Notes is in the Notes Rich Text Format but may be set to MIME.

Choose File/Mobile/Edit Current Location
Select the mail tab
In the field, "Format for messages addressed to Internet addresses", select MIME Format
instead of Rich Text Format.

To send mail or news postings in plain text or HTML or both:

Choose File/Preferences/User Preferences
Click the Mail and News Icon
Under "Internet message format" (or Internet News Format), choose an option:
Plain text
HTML format
HTML and Plain Text.

Mac OS X Mail

MIME and HTML are enabled by the mail program's default rich text format (RTF) but can easily
be turned off on a message-by-message basis. Simply opening a new message window and then go
to the "Format" menu and select "Make Plain Text".

You can turn off RTF permanently by going to the "Mail Menu" and select "Preferences" then
choose "Composing". At the top of the new window select "Format: Plain Text". Now all outgoing
messages are plain text by default.

NOTE: AOL 10.2.1 for Mac OS X appears incapable of sending plain text e-mail.

Novell Groupwise

Generally it is assumed that the e-mail server does not alter the message at all, and that the sender
and their client software is entirely in control of the message which is sent. In some systems, such
as Lotus ccMail, Lotus Notes, Microsoft Exchange or Novell Groupwise, the client and server do
not follow this model, do not use Internet standards and do not necessarily follow the conventions
and standards of Internet e-mail. In those cases compatibility with Internet standards may be
handled by a third item of software - a gateway. Thus there can be problems of a significant
difference between what the sender sees when they write the e-mail (which is probably similar to
how it appears to recipients in their office), and what is actually sent to Internet recipients.

Users of Internet compliant software sometimes disparage the continued use of proprietary systems
such as Novell Groupwise or Lotus Notes, based on the awkward or hard-to-read e-mails they
sometimes receive from these systems. However their continued use is inevitable since within their
own system they provide additional powerful "groupware" functionality which is valuable to larger
organizations and which cannot currently be provided with standard Internet protocols. All these
systems can be configured to respect Internet technical standards and conventions (although
perhaps not in a way which the sender can see or control) - the problem is that they are sometimes
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mis-configured by default, creating difficulties for all their users.

Some e-mail client programs can be configured (or are configured by default) to send each
paragraph as one long line. Some e-mail systems such as Groupwise (and apparently Lotus Notes),
have a single setting in the server (the Message Transfer Agent, which may include a SMTP
gateway) which either wraps all outgoing e-mails of all users to a particular line length, or sends all
e-mails of all users with each paragraph as an arbitrarily long line (unless the user manually sets the
line length by pressing "enter"). In neither case does the user control this single, system-wide,
setting. Nor may the server's wrapping correspond to what they see on screen when writing.

Arbitrarily long lines can be sent within SMTP standards using the "quoted-printable" MIME type.

If such arbitrarily long lines are sent as plain text, then the 1,000 character limit of SMTP may be
reached and the sending client or system may wrap the line arbitrarily there, or may send it out
longer than 1,000 characters. If this happens, a recipient SMTP server may reject it, or break the
line. In one instance a plain text e-mail from Groupwise 4.2 exceeded the 1,000 character per line
limit. That paragraph, of 1,253 characters was broken in mid word by a SMTP server just before
the 1,000th character. This and later versions of Groupwise are used in a significant number of
VET institutes, where the system is valued for many functions apart from its Internet e-mail
capabilities.

Quoting styles. The established approach to quoting a line of text: "> " or ">" is no longer the only
approach. Other methods, which are the default in Groupwise and perhaps other clients or e-mail
systems, are much harder to understand, at least in some circumstances, since they mark only the
start of the paragraph as a comment, rather than the start of each line. A plethora of incompatible
quoting styles is a source of error and frustration for novices and experienced users alike - so an
operational guideline standardise on "> " or ">" was decided upon, with the matter to be reviewed
within 12 months or so.

I have been informed that the issue regarding line wrapping is indeed set at the gateway - in
Groupwise 5.2 and up, this is known as the "GWIA". There are additional settings controlling the
type of MIME encoding, etc.

Additionally, in GW5.5 EP (for Enhancement Pack) and higher on Windows, HTML first became
available for reading and authoring mail (provided Internet Explorer is installed).

In Groupwise 5.5EP, the message format is controlled from the Groupwise client. When composing
mail:

Click on "View"
Then select either "Plain Text" or "HTML"

The client then remembers that setting.

WARNING: The GW client will turn the HTML setting back on all by itself if the user receives or
reads e-mail that has been MIME encoded with HTML.

Pegasus Mail 3.x
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Select "Tools" then click on "Options..."
Click on "Sending Mail" tab
In "When sending messages containing rich (formatted) text" section
Check the radio button "Always remove formatting."
In "Advanced settings" section, uncheck all four options Make sure "Allow 8-bit MIME
message is unchecked"
Click on "OK"

Pegasus Mail 4.x

Select "Tools" then click on "Options..."
Click on "Sending Mail" tab
In "Message Formatting, Formatting and use of styling in messages" section:

Disable all text styling options (never send styled mail) -- should be checked. This is
the key item to set for sending plain text
Do not display the editor 'styles' toolbar -- unimportant to what's actually sent but if
you check it you will not get the false sense that you are sending formatted mail as the
visible formatting options will be removed from the editor screen.
Always paste plain text in preference to styled text -- Should be checked though it is
implied if "Disable all text styling options" is set as noted above.

In "Sending Mail, Rich Text (formatted) Message Handling" section:
Generate multipart/alternative versions of richtext messages -- should be unchecked.
For mail sent to local addresses, use MS-RTF formatting -- should be unchecked but
does not affect Internet mail.

In "Advanced settings" section:
Send enclosures instead of attachments -- normally checked, unrelated to plain text
versus formatted message issues.
Make sure "Allow 8-bit MIME message is unchecked"
Don't add "attachment information" sections to Multipart messages -- should be
checked
Suppress BCC field listings in outgoing mail -- not important to plain text issues but is
normally checked for other reasons.

Click on "OK"

Pine 4.x (Unix)

Start Pine from UNIX prompt, i.e., pine
From Main Menu, select "S" (SETUP- Configure Pine Options)
Select or type "C" (Config)
Type "w" (Word to find:) and enter "character-" to find Character-Set. Leave as <No Value
Set>. It defaults to US-ASCII or set it explicity to "US-ASCII"
Type "w" (Word to find:) again and enter "include-" to find Include-attachments-in-reply.
Leave or set the box to unchecked
This feature controls an aspect of Pine's Reply command. If set, any MIME attachments that
were part of the original message will automatically be included in the Reply.
Select or type "E" (Exit) and type "Y" to commit changes
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Select or type "Q" (Quit), type "Y"

Pine 4.x (Windows)

Start Pine and Login
From Main Menu, select "S" (SETUP- Configure Pine Options)
Select or type "C" (Config)
Type "w" (Word to find:) and enter "character-" to find Character-Set. Leave as <No Value
Set>. It defaults to US-ASCII or set it explicity to "US-ASCII"
Type "w" (Word to find:) again and enter "include-" to find Include-attachments-in-reply.
Leave or set the box to unchecked
This feature controls an aspect of Pine's Reply command. If set, any MIME attachments that
were part of the original message will automatically be included in the Reply.
Select or type "E" (Exit) and type "Y" to commit changes
Select or type "Q" (Quit), type "Y"

Poco v2.xx

Poco supports receiving and sending of both Styled mail (also known as HTML mail) and plain text
mail.

Make sure the Style toolbar is showing (View, Show Style Toolbar menu)
To send a plain message, depress the Styled button. The state of Styled button and the menu
can be saved to default to your preferred state, in Program Options (F7), Defaults section.

TheBat! v1.18

Select "Account" from the main menu
Click on the "Transport" icon
In the section "8-bit characters are treated", click on "Without changes"

NOTE: 8-bit characters are treated - this radio group allows you to set the method used to
handle 8-bit (non-ASCII) characters. If you are using only the English alphabet, this feature
is not very significant to you because all English characters are ASCII characters and will go
through the net without any problems. However, if you are using accented characters or
character sets other than English, you should choose the method carefully because there still
are some mail servers which do not allow appearance of 8-bit characters in e-mail messages.
If you are not sure that such servers are functioning in the way you write your messages, it is
better to choose either Base64 or Quoted-printable encoding. The difference between these
two encoding methods is that Base64 produces totally unreadable text. Quoted-printable
encoding still can be read if your alphabet is almost Latin, only accented characters are
encoded. If your recipient's are using The Bat! or another program which can recognise
Base64 and quoted-printable encoding automatically, you may choose either of these two
methods.
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Click on the "Options" icon
Uncheck the check box in front of "Allow 8-bit characters in message header"
Click OK
Select "View" from the main menu
Click on "Encoding" then select "None"
Select "Options" from the main menu
Select on "Language" then click on "English"

Yahoo Mail

NOTE: Some features are only available to IE users. Netscape and other browsers will not show
these options.

After signing in to Yahoo Mail, some general setup items shoukd be done.

Click "Check Email" under "Message Center" on left side of screen
Select "Mail Options" from right-hand side of main toolbar
From " Mail Options Screen " select "General Preferences" (see Personalization)
Under "Forwarding Messages" (Message Actions) select "forward as in-line text"
Under "Replying" (Message Actions) select "include full original message"
Click Save button

Make sure you set plain text signature as the default.

Select "Mail Options" from right-hand side of main toolbar
From " Mail Options Screen " select "Signature" (see Personalization)
If using IE, then next to "Editor" select "Plain"
If using Netscape or other browser, next to "This signature is: " select the "plain text" bullet
Click Save button

When Replying or Forwarding, edit the previous text and remove all footer material before adding
your new text.

If using IE (not available in Netscape and other browsers) when in the "Compose" window, make
sure "Plain" is selected rather than "Color and Graphics". These two choices are a toggle switch.
Clicking on one activates it and turns off the other.

In any browser, also make sure the "Allow HTML tags" checkbox at the bottom is NOT checked.

If you want to add a signature, check the "Add signature" checkbox.

WebTV

There are some sites on the 'net like HTML for WebTV E-Mail and How To Use HTML In
WebTV E-Mail that inform users to add HTML coding to their WebTV signature, PLEASE
IGNORE THIS BAD ADVICE!

http://www.geocities.com/ResearchTriangle/8795/howto.webtv.html
http://members.tripod.com/%7EStarfish9/index-2.html
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WebTV users should NEVER leave an HTML signature "added" when posting anywhere outside
of the WebTV Community OR e-mailing to a non-WebTV user. Unless you remove it, they will
probably receive your message as an attachment and will be less than happy with you. Attachments
are the number one purveyor of viruses. See WebTV Flood virus for example.

How to Set Up a Signature and Remove HTML coding

Click on Setup on the sidebar
Click on Signature
Remove the HTML codes (if any) from the text entry box
Add a simple maximum 4-line signature in the text entry box
Click Done
Click Done again

If you using an HTML signature, then you MUST make sure to remove it before posting to non-
WebTV users. Your mail should be compatible with other user's systems by using only plain text
and no HTML.

On the WebTV e-mail "Write Page"
Click on "Remove Signature" at left of "Send" button
Send e-mail

NOTE: The default in the WebTV e-mail Write page is set to include the signature.

Examples of actual HTML/MIME encoded mail

The examples seen below were actually received by me in my UNIX Pine mail program. These
show what I actually see when I open the message in Pine. The only thing I have changed is the
users identity.

Received: from engine2.hyperia.com ([208.198.156.11])
   by no2.superb.net (8.11.1/8.11.1) with ESMTP id f3MA0eC18408
   for <gboyd@expita.com>; Sun, 22 Apr 2001 06:00:41 -0400 (EDT)
Received: from c2 ([208.198.157.163]) by engine2.hyperia.com
     (Post.Office MTA Undefined release Undefined
     ID# 589-65135U6000L100S0) with SMTP id AAA24823
     for <gboyd@expita.com>; Sun, 22 Apr 2001 10:57:57 +0100
Message-ID: <002d01c0cb1b$62570700$a39dc6d0@c2>
From: xxxxxxxx@hyperia.com (Cxxxxx Txxxxxxxxxxxxxx)
To: <gboyd@expita.com>
Subject: Firewalls
Date: Sun, 22 Apr 2001 11:00:02 -0000
MIME-Version: 1.0
Content-Type: multipart/alternative;
   boundary="----=_NextPart_000_002A_01C0CB1B.61521A20"
X-Priority: 3
X-MSMail-Priority: Normal
X-Mailer: Microsoft Outlook Express 5.00.2314.1300
X-MimeOLE: Produced By Microsoft MimeOLE V5.00.2314.1300
Parts/Attachments:
   1   OK    ~25 lines  Text (charset: ISO-8859-1)

http://www.f-secure.com/v-descs/webtv.shtml
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   2 Show
n   ~49 lines  Text (charset: ISO-8859-1)
----------------------------------------

    [ Part 1, Text/PLAIN (charset: ISO-8859-1 "Latin 1")  25 lines. ]
    [ Not Shown. Use the "V" command to view or save this part. ]

    [ The following text is in the "iso-8859-1" character set. ]
    [ Your display is set for the "US-ASCII" character set.  ]
    [ Some characters may be displayed incorrectly. ]

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<HTML><HEAD>
<META content="text/html; charset=iso-8859-1" http-equiv=Content-Type>
<META content="MSHTML 5.00.2314.1000" name=GENERATOR>
<STYLE></STYLE>
</HEAD>
<BODY bgColor=#ffffff>
<DIV><FONT face=Arial size=2>
<DIV><FONT face=Arial size=2>I work for a company with 20 or so networked
computers and no connection to the outside world. Our e-mail is currently
received through standalone dialup PC's which ar
e not connected to the
Network.</FONT></DIV>
<DIV>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>What we now wish to do is have continuous access
to
an e-mail server on the Internet for all our LAN PCs. We do not intend to allow
any Internet browsing or any other Internet Services whatsoever.</FONT></DIV>
<DIV>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>We are using Windows NT as the operating system
for
our LAN network and may in the future upgrade to win 2000.</FONT></DIV>
<DIV>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>My Question is: If only EMAIL will be used is a
Firewall really necessary. i.e. does the operating system itself ( be it NT or
the newer 2000) allow for blocking all services BUT e-mail? If yes, having
people
use all Internet services via e-mail, will it present a security
risk?</FONT></DIV>
<DIV>&nbsp;
</DIV>
<DIV><FONT face=Arial size=2>It is not really the additional expense of the
firewall that I am concerned about, rather it is the additional complexity and
knowledge involved with a firewall that concerns me.</FONT></DIV>
<DIV>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>I will be grateful for your reply</FONT></DIV>
<DIV>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>Regards,</FONT></DIV>
<DIV>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>Cxxxxx Txxx</FONT></DIV>
</FONT></DIV></BODY></HTML>

Date: Mon, 2 Apr 2001 20:51:57 -0400
From: Envision <nvision@envisionfirst.com>
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To: friend <eoe@envisionfirst.com>
Subject: equipment
Parts/Attachments:
   1.1   OK     ~71 lines  Text (charset: ISO-8859-1)
   1.2 Shown   ~183 lines  Text (charset: ISO-8859-1)
   2   13 KB     Image
   3  2.7 KB     Image
   4  2.3 KB     Image
   5  5.4 KB     Image
----------------------------------------

    [ Part 1.1, Text/PLAIN (charset: ISO-8859-1 "Latin 1")  71 lines. ]
    [ Not Shown. Use the "V" command to view or save this part. ]

    [ The following text is in the "iso-8859-1" character set. ]
    [ Your display is set for the "US-ASCII" character set.  ]
    [ Some characters may be displayed incorrectly. ]

[IMAGE]

www.envisionfirst.com

Envision Ophthalmic Equipment is Buying and Selling Ophthalmic
Instruments

[IMAGE]

[IMAGE]

Envision is looking to purchase used ophthalmic equipment.&nb
sp;  Age and
condition does not matter, so take a look in your closets, backrooms,
garages, storage, or just an extra lane your not using and make a list
and e-mail it to: selling@envisionfirst.com or fax it to: 734.354.8693

 *  B&L Refractors

 *  AO RX Masters

 *  AO 590
[snip]
[IMAGE]

    [ Part 2, Image/JPEG  18KB. ]
    [ Cannot display this part. Press "V" then "S" to save in a file. ]

    [ Part 3, Image/JPEG  3.6KB. ]
    [ Cannot display this part. Press "V" then "S" to save in a file. ]

    [ Part 4, Image/JPEG  3.1KB. ]
    [ Cannot display this part. Press "V" then "S" to save in a file. ]

    [ Part 5, Image/JPEG  7.2KB. ]
    [ Cannot display this part. Press "V" then "S" to save in a file. ]
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Received: from mclean.mail.mindspring.net (mclean.mail.mindspring.net
  
    [207.69.200.57])
  
   by no2.superb.net (8.11.1/8.11.1) with ESMTP id f3MJHeo17266
   for <gboyd@expita.com>; Sun, 22 Apr 2001 15:17:41 -0400 (EDT)
Received: from JASON (user-vcauipu.dsl.mindspring.com [216.175.75.62])
   by mclean.mail.mindspring.net (8.9.3/8.8.5) with SMTP id PAA17437
   for <gboyd@expita.com>; Sun, 22 Apr 2001 15:17:41 -0400 (EDT)
From: "Jxxxx Fxxxxx" <xxxxxxx@earthlink.net>
To: <gboyd@expita.com>
Subject: Setting Up Earthlink DSL on Two machines
Date: Sun, 22 Apr 2001 15:26:10 -0400
Message-ID: <CIEPLOKFNPMNMPOHOHCEGEDGCAAA.xxxxxxx@earthlink.net>
MIME-Version: 1.0
Content-Type: multipart/alternative;
   boundary="----=_NextPart_000_0000_01C0CB40.8F202D50"
X-Priority: 3 (Normal)
X-MSMail-Priority: Normal
X-Mailer: Microsoft Outlook IMO, Build 9.0.2416 (9.0.2911.0)
  
Importance: Normal
X-MimeOLE: Produced By Microsoft MimeOLE
 V5.50.4133.2400
 
Parts/Attachments:
 
   1   OK     10 lines  Text (charset: ISO-8859-1)
 
   2 Shown   ~23 lines  Text (charset: ISO-8859-1)
----------------------------------------

    [ Part 1, Text/PLAIN (charset: ISO-8859-1 "Latin 1")  10 lines. ]
    [ Not Shown. Use the "V" command to view or save this part. ]

    [ The following text is in the "iso-8859-1" character set. ]
    [ Your display is set for the "US-ASCII" character set.  ]
    [ Some characters may be displayed incorrectly. ]

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<HTML><HEAD>
<META http-equiv=Content-Type content="text/html; charset=iso-8859-1">
<META content="MSHTML 5.50.4611.1300" name=GENERATOR></HEAD>
<BODY>
<DIV><FONT face=Arial size=2><SPAN class=187582319-22042001>I read your article
of how you set up Earthlink DSL on all your machines.&nbsp; I am running two
machines both window
s 2000. I have two network cards in one and one
network card in the other.&nbsp; I enable Internet Connection Sharing on the
DSL
connection and can't get the second machine to connect.&nbsp; File sharing is
working perfectly so the computers and connected correctly.&nbsp; Any
Ideas.</SPAN></FONT></DIV>
<DIV><FONT face=Arial size=2><SPAN
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class=187582319-22042001></SPAN></FONT>&nbsp;</DIV>
<DIV><FONT face=Arial size=2>Jxxxx Fxxxxx</FONT></DIV>
<DIV><FONT face=Arial size=2>xxxxxxx@earthlink.net</FONT></DIV>
<DIV>&nbsp;</DIV></BODY></HTML>

Date: Wed, 15 Aug 2001 01:01:32
       From: htwkh@21cn.net
       To: gbp2@one.net
       Subject: ñ²ðï¡¢¹ÇÑ×·çÊª¡¢Ö×Áö¡·²¡»¼ÕßµÄ¸£Òô

[ The following text is in the "DEFAULT_CHARSET" character set. ]
[ Your display is set for the "US-ASCII" character set. ]
[ Some characters may be displayed incorrectly. ]

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
<HTML><HEAD><TITLE></TITLE>
<META content="text/html; charset=gb2312" http-equiv=Content-Type>
<META content="MSHTML 5.00.2614.3500" name=GENERATOR></HEAD>
<BODY><B>ÊÕ¼þÈË:</B> htwkh@21cn.net<BR><B>Ö÷Ìâ:</B>
¡¶ñ²ðï¡¢¹&Cce
dil;Ñ×·çÊª¡¢Ö×Áö¡·²¡»¼ÕßµÄ¸£Òô<BR>
<P><FONT size=2>ÏÈÉú/Å®Ê¿£ºÄúºÃ£¿<BR>&nbsp;&nbsp;&nbsp;
´ËÐÅÊÇ¡¶ñ²ðï¡¢¹ÇÑ×·çÊª¡¢Ö×Áö¡·²¡»¼ÕßµÄ¸£Òô£¬Ö»·¢Ò»´Î£¬¾ø·ÇÀ¬»ø¡£Èç¸óÏÂ»òÇ×ÓÑÖÐ²¢
ÎÞ´Ë²¡£¬ÎÒ&Atil
de;ÇÎª´ËÐÅ±íÊ¾µÀÇ¸£¬Çë¼´É¾³ý¡£¡¶³þÌìñ²ðï¡¢¹ÇÑ×·çÊª¡¢Ö×Áö²¡ÖÎÁÆ¿µ¸´ÖÐÐÄ¡·
£¬ÊÇÒ»¼ÒÃæÏòÈ«¹ú¼°¸Û¡¢°Ä¡¢Ì¨£¬¾Óª20¶àÄê£¬ÒÔÖÎÁÆñ²ðï¡¢¹ÇÑ×·çÊª¡¢Ö×Áö²¡ÎªÖ÷µÄ¿µ¸´

ÖÐÐÄ¡£±¾ÖÐÐÄÔÚÖÐÒ½ÁùÊÀµ¥´«ÃØ·½µÄ»ù´¡ÉÏ£¬²ÉÓÃÖÐÒ©ÌáÈ¡ÎïÑÐÖÆÁË×îÐÂ1£ 4ºÅÒ©Îï£¬Ò»¸Ä
ÏÈÇ°µÄ´ó°üÐ¡´üÒ©£¬ÌÀ¹øÀï¼åµÄ·½Ê½£¬ÖÎÁÆ²»Í¬ÀàÐÍ<<ñ²ðï¡¢¹ÇÑ×·çÊª¡¢Ö×Áö>>²¡&p
ound;¬¸±×÷ÓÃ

ÉÙ£¬ÁÆÐ§ºÃ£¬×ÜÓÐÐ§ÖÎÓúÂÊ´ï96.5%ÒÔÉÏ¡£<BR>ÈçÓÐÒâÔÚÎÒÖÐÐÄÖÎÁÆ»òÖªµÀÏêÏ¸Çëµ½<A
href="http://htwkh.51.net"
target=_blank>http://htwkh.51.net</A>ÎÒÃÇÁªÏµ¡£<BR></FONT><FONT
size=2>µç»°£º0728¡ª5336186&nbsp;&nbsp;<BR>ÏêÏ¸µØÖ·£ººþ±±Ê¡ÌìÃÅÊÐ»ÆÌ¶ÐÂ½Ö8&or
dm;Å5<BR>

ÓÊÕþ±àºÅ£º431708<BR>Ö÷ÖÎÒ½Ê¦£ºÍõ·½ÁÖ<BR>¿µ¸´ÖÐÐÄÐÅÏä£º<A
href="mailto:htwkh@21cn.net">htwkh@21cn.net</A>.<BR>´ËÖÂ<BR>¾´Àñ</FONT>
</P></BODY></HTML>

Nasty looking, aren't they? No wonder I dislike HTML e-mail. The worse
of them is the next sample, a base64 (MIME) encoded message.

Received: from city.cityedu.com ([211.37.94.194])
     by listserv.aol.com (8.8.8/8.8.8)
     with SMTP id MAA11272 for <accmail@listserv.aol.com>;
     Sun, 22 Apr 2001 12:29:33 -0400 (EDT)
From: i284497472@hotmail.com
Received: from 211.37.94.194 (unverified [163.30.52.134]) by city.cityedu.com
 (EMWAC SMTPRS 0.83) with SMTP id <B0000006866@city.cityedu.com>;
 Mon, 23 Apr 2001 01:22:42 +0900
Date: Mon, 23 Apr 2001 01:22:42 +0900
Message-ID: <B0000006866@city.cityedu.com>
Reply-To: i284497472@hotmail.com
To: i284497472@hotmail.com
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Subject: ¡¾¡¾¡¾Flying Shose!!¡¾¡¾¡¾¡¾Flying Shose!!¡¾¡¾¡¾
MIME-Version: 1.0
Content-Type: text/html; charset=big5
Content-Transfer-Encoding: base64

PGh0bWw+DQoNCjxoZWFkPg0KPG1ldGEgaHR0cC1lcXVpdj0iQ29udGVudC1UeXBlIiBjb250
ZW50PSJ0ZXh0L2h0bWw7IGNoYXJzZXQ9YmlnNSI+DQo8dGl0bGU
+Zmx5c2hvc2U8L3RpdGxlvdSBjYW4ndCBzZWUgKGFuZCBoZWFyKSB0aGUgYWJvdmUgYW5pbWF0aW9uLCB5b3UgReferences:

How to turn off HTML being sent out (Windows) Eudora
How do I write a "plain text" email? IncrediMail
How to turn off HTML in Various E-mail Programs Rootsweb
How to Turn OFF HTML or RTF in Various E-mail Software Programs University of
Arkansas
AOL Communicator Help see Page 66
Attacks by Attactments Norton AntiVirus
Configuring Mozilla Thunderbird to Send Plain ASCII Text Blogzilla - a weblog about
Mozilla
Demime a tool to scrub MIME from mailing lists
Forte-agent FAQ v1.5 (modified 9/14/97)
Juno search http://www.expressresponse.com/cgi-bin/progsnp/juno/srchjnnp ?
search_type=vdocument&search_input=5074.htm&
session_id=981056986.1809.2&submit.x=69&submit.y=7
List of banned file extensions University of Rochester
LISTSERV mailing list program
Majordomo mailing list program

http://www.eudora.com/techsupport/kb/908hq.html
http://www.incredimail.com/english/faq/plaintext.html
http://helpdesk.rootsweb.com/help/html-off.html
http://www.uark.edu/campus/compserv/internet/email/emailsoftchart.html
http://channelevents.aol.com/flash/com_mentor/guide.pdf/
http://service4.symantec.com/SUPPORT/ent-security.nsf/d94e5761249762e885256885005de964/ee9d0bde5374414c88256a930048df99?OpenDocument
http://www.deftone.com/blogzilla/archives/configuring_mozilla_thunderbird_to_send_plain_ascii_text.html
http://scifi.squawk.com/demime.html
http://www.faqs.org/faqs/off-line-readers/usenet/forte-agent/index.html
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http://www.infosec.rochester.edu/virus.html
http://www.lsoft.com/
http://www.greatcircle.com/majordomo/
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Unofficial AOL E-mail FAQ
Unsafe File Extensions TechTV
(http://www.transport.com/asciimail.html) Turning off HTML Mail (defunct as of 24Oct00)
We Can Put an End to Word Attachments GNU article Jan 2002
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